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Trademarks 

The following are trademarks of Motorola: MOTOTRBO™.  

 

Any other brand or product names are trademarks or registered trademarks of their respective holders.  

Copyright 

Copyright © 2015; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are 

reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, 

in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, 

manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A: 

The Genesis Group and Phil Burks 

5800 Eagles Nest Blvd 

Tyler, Texas 75703. 

 

Includes technology licensed from Motorola. 

Disclaimer 

The GenFIT for MOTOTRBO User’s Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The 

Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks 

GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make 

periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does 

not assume responsibility to notify any person of such revisions or changes. While we have taken strides to 

carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil 

Burks assume no responsibility for the use of the manual, or GenFIT for MOTOTRBO software, nor for any 

patent infringements or other rights of third parties who may use the manual or the GenFIT for MOTOTRBO 

software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or 

warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid 

by the end-user. 

 

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or 

software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed 

these statements. 

License 

Title to the media on which the program is recorded and to the documentation in support of the product is 

transferred to you, but title to the program, and all subsequent copies of the program, despite the form or 

media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the 

selection of the program to achieve your intended results, and for the installation, use, and results obtained 

from the program. 

Support 

Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best 

software possible, and we want to know when you have any questions, concerns or problems with GenFIT 

for MOTOTRBO so that we can make it a better product for everyone. Please see the support chapter in this 

document for details on contacting support. 
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About this Manual 

 

Goals 

This manual describes the role and function of the GenFIT product. 

Who Should Read This Manual? 

This manual is written for the intended audience of novice to mid-level 

MOTOTRBO radio system users and novice to mid-level PC users.  

How This Manual Is Organized 

This manual is organized as follows: 

 Overview: Describes briefly what GenFIT is and its intended use. 

 Installation: Describes how to install GenFIT. 

 Getting Started: Describes how to configure GenFIT for use. 

 Operation: Describes how to utilize GenFIT’s functionality. 

 Support: Describes how to get support for GenFIT. 

 

This manual contains the following images, used to indicate that a segment of text 

requires special attention: 

  Additional Information: Additional information is used to indicate 

shortcuts or tips. 

  Warning: Warnings are used to indicate possible problem areas, such 

as a risk of data loss or incorrect/unexpected functionality. 
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Chapter 1 Overview 

 
 

This chapter briefly describes GenFIT, its functionality and its intended use. 

 

This chapter contains the following sections: 

 What is GenFIT? Describes GenFIT’s purpose and functionality. 

 How is GenFIT used? Describes GenFIT’s intended use. 

 

What is GenFIT? 

The name GenFIT stands for Genesis Field Investigation Tool. GenFIT is a 

standalone diagnostic tool, designed to provide basic “in-the-field” system 

information. GenFIT can connect to the following TRBO connection types: 

 RF Control Station: Up to 2 control stations. 

 IP Site Connect: Wide-area only. 

 Capacity Plus 

 

How is GenFIT used? 

GenFIT’s compact design enables it to be installed on a laptop (or similar device) 

and used out in the field as a convenient diagnostic resource. GenFIT is used in 

conjunction with 1-2 USB-attached Control Stations or IP connectivity to a 

MOTOTRBO system in order to receive data.  
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Chapter 2 Installation 

 
 

This chapter covers the process of installing GenFIT and contains the following 

sections: 

 Installation: Describes the procedure for installing GenFIT. 

 

Minimum Hardware Specifications 

See http://www.genesisworld.com/GenFIT/ 

 

Installation 

The GenFIT Installation package contains the following files:  

 

 GenFITInstaller.msi: Contains the GenFIT installation files. 

 

Double-click GenFITInstaller.msi to launch the GenFIT installation. The 

installation will first verify that the Microsoft .Net Framework 4.0 has been 

installed on the machine. GenFIT cannot be installed if this prerequisite is 

missing. 

 

The first installation window is the Welcome window, as shown in Figure 2.1. 

Click Next to continue. Click Cancel on any window to exit the installation. 

 

 
Figure 2.1 – Welcome Window 

 

 

http://www.genesisworld.com/GenFIT/


© 2015 The Genesis Group 12 
All Rights Reserved  
Printed in the U.S.A. 600-2.11.0-JJ.1 

 

 

 

 

The License Agreement window, shown in Figure 2.2, displays the end user 

license agreement for GenFIT. After reviewing the agreement, select I Agree and 

click Next to continue.  

 

 
Figure 2.2 – License Agreement Window 

 

The Destination Folder window, shown in Figure 2.3, displays the installation 

folder. If you would like to change this folder, click the Change... button. Click 

Next to continue.  

 

 
Figure 2.3 – Destination Folder Window 
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Figure 2.4 – Change Destination Folder Dialog 

 

The Ready to install GenFIT window is shown in Figure 2.5. Click Install to 

proceed with the installation. Click Back to change installation options. 

 

 
Figure 2.5 – Ready to install GenFIT Window 
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The Installing GenFIT window, shown in Figure 2.6, is displayed while program 

files are being transferred. 

 
Figure 2.6 – Installing Window 

 

Figure 2.7 shows the Installation Complete window. GenFIT program files have 

been installed and are ready to use. Click Finish to exit the installation. 

 

 
Figure 2.7 – Installation Complete Window 

 

 The GenFIT Installer package places a shortcut on the desktop for convenience.  
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Chapter 3 Getting Started 

 
 

This chapter describes how to properly start and connect GenFIT to either a USB-

attached Control Station or MOTOTRBO system. 

 

This chapter contains the following sections: 

 Starting a Connection: Describes how to connect to your MOTOTRBO 

system. 

 Disconnecting: Describes how to disconnect from your MOTOTRBO 

system. 

 

 

 The menu entry File -> Select License should be ignored. A license is not required for using GenFIT to 

connect to TRBO systems. 
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Starting a Connection 

To receive packets from your MOTOTRBO system, you must set up a connection 

by taking the following steps: 

 

1. Select Connection from the menu: 

2. Click on the TRBO option to start the setup.  

 
Figure 3.1 – Connection Selection 

 

Select the source connection type. 

 
Figure 3.2 – Source Selection 
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Settings: 

 Source: One of the following options: 

o RF Control Station: Select this option to connect to one or 

two RF control stations for over-the-air monitoring. 

o IP Site Connect: Select this option to connect via Ethernet 

to an IP Site Connect system.  

o Capacity Plus: Select this option to connect via Ethernet to 

a Capacity Plus system.  

 IP Address and Port: Static IP address and Port of the master 

peer repeater on the peer network. 

 IP Address(es): IP Address(es) of the RF control station(s).  

 Peer ID: The peer ID used by GenFIT when connecting to the 

MOTOTRBO peer network. 

 Authentication: The authentication key used by GenFIT to 

connect to a MOTOTRBO peer network.  

 Show Link Establishment (LE) Packets: If checked, GenFIT will 

display link establishment packets between GenFIT and the 

repeaters. Unchecking this will reduce the amount of traffic shown 

on the Activity view. 

 OTA Logging: If checked, the control station radio will use 

Motorola’s OTA Logging feature to get a more complete view of 

system activity. This feature requires a radio using R01.06.00 or 

higher firmware. When using control stations to monitor the 

system, it is highly recommended to enable this option. 

3. Click the OK button to start the connection. 
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IP Peer Connections 

In an IP peer connection, as used for an IP Site Connect or Capacity Plus system, 

all repeaters must be accessible to the GenFIT computer via UDP. The GenFIT 

computer must be connected to the same network.  

 

GenFIT will connect to the master peer repeater you specified by IP Address and 

Port in the TRBO connection settings. No additional configuration is needed for 

GenFIT to monitor activity on the other repeaters on the network. 

 

IP Site Connect 

When connected via IP to an IP Site Connect system, GenFIT can monitor all 

activity on your system. 

 

To create an IP Site Connect connection, select IP Site Connect from the Source 

drop-down list and enter the settings detailed above. 

 

Capacity Plus 

Monitoring a Capacity Plus MOTOTRBO system using GenFIT works in much 

the same way as on an IP Site Connect system.  

 

To create your Capacity Plus connection, select Capacity Plus from the Source 

drop-down list and enter the settings detailed above. 

 

 
Figure 3.3 – IP Site Connect Connection Settings 
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Figure 3.4 – Capacity Plus Connection Settings 

RF Control Station Connections 

A control station is an ordinary radio (portable or mobile) that has been 

physically connected to the GenFIT computer to listen to activity on a system. 

 

An RF Control Station connection in GenFIT allows you to use an ordinary 

MOTOTRBO radio to monitor activity on your system. You may use either a 

portable or mobile radio for this purpose. A local connection to a MOTOTRBO 

radio utilizes the same USB cable required for programming the radios with the 

Customer Programming Software (CPS); therefore, the MOTOTRBO radio must 

be located near the PC to connect the cable. 

 

A control station is required for each timeslot you wish to monitor, up to two. 

 

 
Figure 3.5 – RF Control Station Connection Settings 

 



© 2015 The Genesis Group 20 
All Rights Reserved  
Printed in the U.S.A. 600-2.11.0-JJ.1 

 

Configuring RF connection IP addresses 

To set up a control station connection, select the RF Control Station option from 

the Source drop-down list. Click the Edit… box to bring up a window where you 

can enter the IP addresses of the control station radios (check the Enabled box to 

enter the IP address) . If you do not know the IP address of the radios, go to the 

Windows Control Panel and select Network and Sharing Center There will be 

a network for each radio plugged into the computer via USB. Click View Status, 

followed by Details…. (See Figure 3.6). Then copy the address contained in the 

IPv4 Default Gateway field. 

 

 
Figure 3.6 – Network Connection Details in Windows 7 
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Figure 3.7 –RF Control Station setup 
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OTA Logging Feature 

A radio that is using the R01.06.00 firmware version or higher can take advantage 

of MOTOTRBO’s Over-The-Air Logging feature to receive a more complete 

view of radio system activity than is possible through a normal control station 

connection. Using OTA Logging allows a single control station to monitor all 

over-the-air activity — group or private, voice or data — on a single repeater 

timeslot. 

 

One control station is required per logical channel to be monitored. Each control 

station must be programmed to listen for transmissions on the channel it will 

monitor and must be in range to receive those transmissions over the air. 

 

 OTA Logging is not supported for Capacity Plus systems. 

 

To activate OTA Logging mode, check the box on the RF Control Station 

connection screen labeled OTA Logging. 

 

 The logged files can be found under the user documents Genesis\GenFit\TRBO\0\ directory. 

Disconnecting 

To disconnect from your MOTOTRBO system, navigate to and unselect 

Connection  TRBO, as shown in Figure 3.8. 

 

 
Figure 3.8 – Checked TRBO menu item, indicating a started connection. 
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Chapter 4 Operation 

 
 

This chapter describes the functionality of and information displayed by GenFIT.  

 

This chapter contains the following sections: 

 Activity View 

 Channel View 

 Busies View 

 Packet Information 

 The information visible in the Activity view is logged, but closing GenFIT or stopping a connection 

then starting a new connection will result in all visual elements (such as scrolling activity or channel blocks) 

being lost. 

 

 
Figure 4.1 – GenFIT 

1 

 

3 
 

2 
 

4 
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Activity View 

The Activity view, shown as area 1 in Figure 4.1, scrolls system activity packets in 

real time, displaying the following fields of information for each packet received 

on your MOTOTRBO system: 

 Description: Broad category of the activity (i.e. Channel Assignments, 

Call Control Notifications, etc.). 

 Group: Target group (if any) of the activity. 

 Radio ID (if any):  

o Originating Radio ID: For channel assignments, call alerts, etc. 

o Targeted Radio ID: For radio-to-radio Inhibits, Radio Checks, 

etc. 

 Type: Activity subcategory. Further describes the type of activity. 

 Target ID: This will contain one of the following values, if the value is 

provided in the packet: 

o Target Radio ID: For call alerts, private calls, etc. 

o Requester ID: For Inhibits, Radio Checks, etc. 

 Channel:  

o IP Site Connect: Will contain the text IPSC. 

o Capacity Plus: The repeater ID on which the activity occurred. 

o RF Control Station: The IP address of the control station on which 

the activity occurred. 

 Timestamp: The date and time when the activity was received or 

originated. This will be the packet timestamp for packets that include a 

timestamp. Otherwise it will be the date and time the packet was received 

by the input module. 

 Elapsed Time: The duration of the activity. Only calls and busies provide 

an elapsed time value. 

 

 Use the pause feature in the activity view to immediately stop the scrolling of packet data and leave 

existing data in the activity list. 
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Activity Filtering 

Suppressing Duplicate Packets 

Some packets may be echoed in triplicate and quadruplicate. Showing more than 

one instance of each of these activities is rarely desired. To enable/disable 

duplicate packets check/uncheck the Suppress Duplicates menu option in the 

Filter menu by clicking on that menu option. 

 

 This option has no effect on many multisite packets, as these packets are generally not sent in duplicate, 

triplicate, etc. 

Packet Throttling 

Throttling ensures that GenFIT will not display a distinct input packet more than 

once per second. To enable/disable packet throttling check/uncheck the Throttle 

menu option in the Filter menu by clicking on that menu option. 

 

 This option has no effect on many multisite packets, as these packets are generally not sent in duplicate, 

triplicate, etc. 

Filtering Packet Types 

GenFIT maintains a list of Packet Types that shows all packet types encountered 

by GenFIT so far. This list will start off empty and will add new packet types as 

they are received by GenFIT. New packets types will default to checked 

(Included) in the Packet Types list. All checked packet types will appear in the 

Activity List as they are received. Packet types that are unchecked will not be 

shown in the Activity List. To open the Packet Type Filter Settings dialog, shown 

in figure 4.2, click By Packet Type in the Filter menu. 

 



© 2015 The Genesis Group 26 
All Rights Reserved  
Printed in the U.S.A. 600-2.11.0-JJ.1 

 

 
Figure 4.2 – Packet Type Filter Settings dialog 
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Channel View 

The Channel view displays decoded channel activity and call information for each 

channel at a given site, shown as area 2 in Figure 4.1. The following fields of 

information for call activity are displayed on the appropriate channel block: 

 Channel: The key of the channel the activity took place on. For IP Site 

Connect, this will be IPSC followed by the slot number. For Capacity 

Plus, this will be the repeater ID followed by the slot number. For RF 

Control Station, this will show the IP address of the control station used to 

monitor the slot on which the activity occurred. 

 Radio ID: Originating radio ID (if any) of the activity. 

 Talkgroup ID: Group (if any) on which the call took place. 

 Target ID: Target of the Private call. 

 Call Type: Group or Private. Data if applicable. 

 Elapsed Call Time: The duration of the activity. Note that calls with 

extremely short durations, such as those consisting of a single data packet, 

may not appear on the channel block until they are over. 

Busies View 

The Busies view, shown as area 3 in Figure 4.1, displays a history of busy 

packets. The following fields of information for busies are displayed from each 

busy packet: 

 ID: Originating radio ID (if any) of the busy. Always 0. 

 Group: Group (if any) on which the busy call took place. 

 Type: Activity subcategory. Further describes the type of activity. 

 Timestamp: The date and time when the busy was received or originated. 

This will be the packet timestamp for packets that include a timestamp. 

Otherwise it will be the date and time the packet was received by the input 

module.  

 Elapsed Time: The duration of the busy.  

Message Panel 

The Message panel, shown as area 4 in Figure 4.1, displays messages for errors, 

and indicates when a connection is started or stopped. 
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Packet Information 

In either Activity view or Channel view, it is possible to see additional 

information about a call or event by double-clicking on a list item or channel, 

respectively. 

 

 
Figure 4.3 – Packet Information window 

 

This window provides a list of all information that GenFIT knows about a 

decoded data packet. When opened in Channel view, information is shown 

pertaining to the current (or last known) activity happening on the double-clicked 

channel. 
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Chapter 5 Support 

 
 

 

For information and support on how to configure your MOTOTRBO radios, 

contact your MOTOTRBO support. 

 

 For support on your GenFIT installation, please email Genesis at 

genfit_support@genesisworld.com. 

 

 GenFIT support is provided by Genesis through email only. 

 

mailto:genfit_support@genesisworld.com

